Copyright

© 2017 Progress Software Corporation and/or its subsidiaries or affiliates. All rights reserved.

These materials and all Progress® software products are copyrighted and all rights are reserved by Progress Software Corporation. The information in these materials is subject to change without notice, and Progress Software Corporation assumes no responsibility for any errors that may appear therein. The references in these materials to specific platforms supported are subject to change.

Business Making Progress, Corticon, DataDirect (and design), DataDirect Cloud, DataDirect Connect, DataDirect Connect64, DataDirect XML Converters, DataDirect XQuery, Deliver More Than Expected, Icenium, Kendo UI, Making Software Work Together, NativeScript, OpenEdge, Powered by Progress, Progress, Progress Software Developers Network, Rollbase, SequeLink, Sitefinity (and Design), SpeedScript, Stylus Studio, TeamPulse, Telerik, Telerik (and Design), Test Studio, and WebSpeed are registered trademarks of Progress Software Corporation or one of its affiliates or subsidiaries in the U.S. and/or other countries. AccelEvent, Analytics360, AppsAlive, AppServer, Arcade, BravePoint, BusinessEdge, DataDirect Spy, DataDirect SupportLink, DevCraft, DigitalFactory, Fiddler, Future Proof, High Performance Integration, JustCode, JustDecompile, JustMock, JustTrace, OpenAccess, ProDataSet, Progress Arcade, Progress Profiles, Progress Results, Progress RFID, Progress Software, ProVision, PSE Pro, SectorAlliance, Sitefinity, SmartBrowser, SmartComponent, SmartDataBrowser, SmartDataObjects, SmartDataView, SmartDialog, SmartFolder, SmartFrame, SmartObjects, SmartPanel, SmartQuery, SmartViewer, SmartWindow, WebClient, and Who Makes Progress are trademarks or service marks of Progress Software Corporation and/or its subsidiaries or affiliates in the U.S. and other countries. Java is a registered trademark of Oracle and/or its affiliates. Any other marks contained herein may be trademarks of their respective owners.

Please refer to the Release Notes applicable to the particular Progress product release for any third-party acknowledgements required to be provided in the documentation associated with the Progress product.

The Release Notes can be found in the OpenEdge installation directory and online at: https://community.progress.com/technicalusers/w/openedgegeneral/1329.openedge-product-documentation-overview.aspx.

For the latest documentation updates see OpenEdge Product Documentation on Progress Communities: (https://community.progress.com/technicalusers/w/openedgegeneral/1329.openedge-product-documentation-overview.aspx).

March 2017

Last updated with new content: Release 11.7.0

Updated: 2017/03/24
Table of Contents

Preface.............................................................................................................................................................7
  Purpose.............................................................................................................................................................7
  Audience.........................................................................................................................................................7
  Organization....................................................................................................................................................8
  Using ABL documentation............................................................................................................................8
    References to ABL compiler and run-time features..................................................................................8
    References to ABL data types..................................................................................................................9
  Typographical conventions..........................................................................................................................9
  Examples of syntax descriptions..................................................................................................................10
    Long syntax descriptions split across lines........................................................................................12
    Complex syntax descriptions with both required and optional elements.............................................12
  OpenEdge messages....................................................................................................................................12
    Obtaining more information about OpenEdge messages........................................................................13

Chapter 1: Understanding Reports..............................................................................................................15
  OpenEdge Management report terminology.........................................................................................15
  OpenEdge Management report types......................................................................................................16
  Report instances ........................................................................................................................................16
    Create Report page................................................................................................................................16
    Report Edit page....................................................................................................................................17
    Creating a report instance....................................................................................................................18

Chapter 2: Historical Reports......................................................................................................................21
  Overview of historical reports...................................................................................................................21
    Working with report templates.............................................................................................................21
  Historical report descriptions.....................................................................................................................22
    Customizing graphical output................................................................................................................29
      Graphical output environment variables..........................................................................................29
    Report output field and column headings...........................................................................................32

Chapter 3: Working with Report Instances..............................................................................................41
  Scheduling reports to run............................................................................................................................41
  Viewing report output................................................................................................................................42
  Viewing report history...............................................................................................................................43
  Scheduled reports.....................................................................................................................................44
  Completed reports...................................................................................................................................44
  Running reports.........................................................................................................................................45
Chapter 4: Creating Custom Report Templates.................................47
  Creating a custom report template..............................................................47
  Editing the report template............................................................................51
  Copying the report template............................................................................52
  Deleting the report template............................................................................52
  Importing and exporting report templates ......................................................52

Chapter 5: Real-time Reports................................................................53
  Introduction.......................................................................................................54
  System Information report................................................................................54
  System Activity report......................................................................................55
  Open Alert Detail report..................................................................................56
  Hotspot report..................................................................................................57
  Database Summary report................................................................................57
  Open Alert Summary report.............................................................................57

Chapter 6: OpenEdge Management Diagnostic Reports .......................59
  Viewing OpenEdge Management log files .....................................................59
  OpenEdge Management Task Scheduler.......................................................60
  OpenEdge Management Work Scheduler.....................................................61

Index...........................................................................................................65
Preface

For details, see the following topics:

• Purpose
• Audience
• Organization
• Using ABL documentation
• Typographical conventions
• Examples of syntax descriptions
• OpenEdge messages

Purpose

This guide describes how to create and run reports using OpenEdge® Management.

Audience

This manual is designed for users of the OpenEdge Management product. Typical users are OpenEdge® database administrators and any others responsible for the daily management of an OpenEdge database.
Organization

Understanding Reports on page 15
Introduces OpenEdge Management report types and OpenEdge Management report terminology and contains steps for creating a report instance.

Historical Reports on page 21
Describes the trend report templates supplied by OpenEdge Management.

Working with Report Instances on page 41
Explains how to schedule reports and view report output. Also contains steps for working with scheduled, completed, and running reports.

Creating Custom Report Templates on page 47
Describes how to create, edit, copy, delete, import, and export custom report templates.

Real-time Reports on page 53
Provides a description of each real-time report.

OpenEdge Management Diagnostic Reports on page 59
Provides an overview of the reports used to debug OpenEdge Management. Includes information on the OpenEdge Management log file and the work scheduler.

Using ABL documentation

OpenEdge provides a special purpose programming language for building business applications. In the documentation, the formal name for this language is *ABL (Advanced Business Language)*. With few exceptions, all keywords of the language appear in all **UPPERCASE**, using a font that is appropriate to the context. All other alphabetic language content appears in mixed case.

For the latest documentation updates see the OpenEdge Product Documentation Overview page on Progress Communities:


References to ABL compiler and run-time features

ABL is both a compiled and an interpreted language that executes in a run-time engine. The documentation refers to this run-time engine as the *ABL Virtual Machine (AVM)*. When the documentation refers to ABL source code compilation, it specifies *ABL or the compiler* as the actor that manages compile-time features of the language. When the documentation refers to run-time behavior in an executing ABL program, it specifies the *AVM* as the actor that manages the specified run-time behavior in the program.

For example, these sentences refer to the ABL compiler's allowance for parameter passing and the AVM's possible response to that parameter passing at run time: "ABL allows you to pass a dynamic temp-table handle as a static temp-table parameter of a method. However, if at run time the passed dynamic temp-table schema does not match the schema of the static temp-table parameter, the AVM raises an error." The following sentence refers to run-time actions that the AVM can perform using a particular ABL feature: "The ABL socket object handle allows the AVM to connect with other ABL and non-ABL sessions using TCP/IP sockets."
References to ABL data types

ABL provides built-in data types, built-in class data types, and user-defined class data types. References to built-in data types follow these rules:

- Like most other keywords, references to specific built-in data types appear in all **UPPERCASE**, using a font that is appropriate to the context. No uppercase reference ever includes or implies any data type other than itself.
- Wherever `integer` appears, this is a reference to the `INTEGER` or `INT64` data type.
- Wherever `character` appears, this is a reference to the `CHARACTER`, `LONGCHAR`, or `CLOB` data type.
- Wherever `decimal` appears, this is a reference to the `DECIMAL` data type.
- Wherever `numeric` appears, this is a reference to the `INTEGER`, `INT64`, or `DECIMAL` data type.

References to built-in class data types appear in mixed case with initial caps, for example, `Progress.Lang.Object`. References to user-defined class data types appear in mixed case, as specified for a given application example.

Typographical conventions

This documentation uses the following typographical and syntax conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bold typeface indicates commands or characters the user types, provides emphasis, or the names of user interface elements.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Italic typeface indicates the title of a document, or signifies new terms.</td>
</tr>
<tr>
<td><strong>SMALL, BOLD CAPITAL LETTERS</strong></td>
<td>Small, bold capital letters indicate OpenEdge key functions and generic keyboard keys; for example, <code>GET</code> and <code>CTRL</code>.</td>
</tr>
<tr>
<td><strong>KEY1+KEY2</strong></td>
<td>A plus sign between key names indicates a <strong>simultaneous</strong> key sequence: you press and hold down the first key while pressing the second key. For example, <code>CTRL+X</code>.</td>
</tr>
<tr>
<td><strong>KEY1 KEY2</strong></td>
<td>A space between key names indicates a <strong>sequential</strong> key sequence: you press and release the first key, then press another key. For example, <code>ESCAPE H</code>.</td>
</tr>
</tbody>
</table>

**Syntax:**

- **Fixed width**
  - A fixed-width font is used in syntax, code examples, system output, and file names.

- **Fixed-width italics**
  - Fixed-width italics indicate variables in syntax.

- **Fixed-width bold**
  - Fixed-width bold italic indicates variables in syntax with special emphasis.
<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPPERCASE fixed width</td>
<td>ABL keywords in syntax and code examples are almost always shown in uppercase. Although shown in uppercase, you can type ABL keywords in either uppercase or lowercase in a procedure or class.</td>
</tr>
<tr>
<td>Period (.) or colon (:)</td>
<td>All statements except <code>DO</code>, <code>FOR</code>, <code>FUNCTION</code>, <code>PROCEDURE</code>, and <code>REPEAT</code> end with a period. <code>DO</code>, <code>FOR</code>, <code>FUNCTION</code>, <code>PROCEDURE</code>, and <code>REPEAT</code> statements can end with either a period or a colon.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Large brackets indicate the items within them are optional.</td>
</tr>
<tr>
<td>[]</td>
<td>Small brackets are part of ABL.</td>
</tr>
<tr>
<td>{ }</td>
<td>Large braces indicate the items within them are required. They are used to simplify complex syntax diagrams.</td>
</tr>
<tr>
<td>{}</td>
<td>Small braces are part of ABL. For example, a called external procedure must use braces when referencing arguments passed by a calling procedure.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>Ellipses indicate repetition: you can choose one or more of the preceding items.</td>
</tr>
</tbody>
</table>

### Examples of syntax descriptions

In this example, `ACCUM` is a keyword, and `aggregate` and `expression` are variables:

**Syntax**

```
ACCUM aggregate expression
```

`FOR` is one of the statements that can end with either a period or a colon, as in this example:

```
FOR EACH Customer NO-LOCK:
    DISPLAY Customer.Name.
END.
```

In this example, `STREAM stream`, `UNLESS-HIDDEN`, and `NO-ERROR` are optional:

**Syntax**

```
DISPLAY [ STREAM stream ] [ UNLESS-HIDDEN ] [ NO-ERROR ]
```
In this example, the outer (small) brackets are part of the language, and the inner (large) brackets denote an optional item:

**Syntax**

```
INITIAL [ constant [, constant ] ]
```

A called external procedure must use braces when referencing compile-time arguments passed by a calling procedure, as shown in this example:

**Syntax**

```
{ &argument-name }
```

In this example, EACH, FIRST, and LAST are optional, but you can choose only one of them:

**Syntax**

```
PRESELECT [ EACH | FIRST | LAST ] record-phrase
```

In this example, you must include two expressions, and optionally you can include more. Multiple expressions are separated by commas:

**Syntax**

```
MAXIMUM ( expression , expression [, expression ] ... )
```

In this example, you must specify MESSAGE and at least one expression or SKIP [( n )], and any number of additional expression or SKIP [( n )] is allowed:

**Syntax**

```
MESSAGE { expression | SKIP [ ( n ) ] } ...
```

In this example, you must specify {include-file, then optionally any number of argument or &argument-name = "argument-value", and then terminate with }:
Syntax

```plaintext
{ include-file
  [ argument | &argument-name = "argument-value" ] ... }
```

Long syntax descriptions split across lines

Some syntax descriptions are too long to fit on one line. When syntax descriptions are split across multiple lines, groups of optional and groups of required items are kept together in the required order.

In this example, `WITH` is followed by six optional items:

Syntax

```plaintext
WITH [ ACCUM max-length ] [ expression DOWN ]
[ CENTERED ] [ n COLUMNS ] [ SIDE-LABELS ]
[ STREAM-IO ]
```

Complex syntax descriptions with both required and optional elements

Some syntax descriptions are too complex to distinguish required and optional elements by bracketing only the optional elements. For such syntax, the descriptions include both braces (for required elements) and brackets (for optional elements).

In this example, `ASSIGN` requires either one or more `field` entries or one `record`. Options available with `field` or `record` are grouped with braces and brackets:

Syntax

```plaintext
ASSIGN { { FRAME frame } { field [ = expression ] }
  [ WHEN expression ] } . . .
| { record [ EXCEPT field . . . ] }
```

OpenEdge messages

OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

- **Execution messages** inform you of errors encountered while OpenEdge is running a procedure; for example, if OpenEdge cannot find a record with a specified index field value.
• **Compile messages** inform you of errors found while OpenEdge is reading and analyzing a procedure before running it; for example, if a procedure references a table name that is not defined in the database.

• **Startup messages** inform you of unusual conditions detected while OpenEdge is getting ready to execute; for example, if you entered an invalid startup parameter.

After displaying a message, OpenEdge proceeds in one of several ways:

• Continues execution, subject to the error-processing actions that you specify or that are assumed as part of the procedure. This is the most common action taken after execution messages.

• Returns to the Procedure Editor, so you can correct an error in a procedure. This is the usual action taken after compiler messages.

• Halts processing of a procedure and returns immediately to the Procedure Editor. This does not happen often.

• Terminates the current session.

OpenEdge messages end with a message number in parentheses. In this example, the message number is 200:

```
** Unknown table name table. (200)
```

If you encounter an error that terminates OpenEdge, note the message number before restarting.

**Obtaining more information about OpenEdge messages**

In Windows platforms, use OpenEdge online help to obtain more information about OpenEdge messages. Many OpenEdge tools include the following Help menu options to provide information about messages:

• Choose **Help > Recent Messages** to display detailed descriptions of the most recent OpenEdge message and all other messages returned in the current session.

• Choose **Help > Messages** and then type the message number to display a description of a specific OpenEdge message.

• In the Procedure Editor, press the HELP key or F1.

On UNIX platforms, use the OpenEdge `pro` command to start a single-user mode character OpenEdge client session and view a brief description of a message by providing its number.

**To use the pro command to obtain a message description by message number:**

1. Start the Procedure Editor:

   ```
   OpenEdge-install-dir/bin/pro
   ```

2. Press F3 to access the menu bar, then choose **Help > Messages**.

3. Type the message number and press **ENTER**. Details about that message number appear.

4. Press F4 to close the message, press F3 to access the Procedure Editor menu, and choose **File > Exit**.
Understanding Reports

You can create a variety of reports based on data in the OpenEdge® Management Trend Database. Each report is based on a report template that is either provided with OpenEdge Management or created by you.

For details, see the following topics:

- OpenEdge Management report terminology on page 15
- OpenEdge Management report types on page 16
- Report instances on page 16

For details, see the following topics:

- OpenEdge Management report terminology
- OpenEdge Management report types
- Report instances

OpenEdge Management report terminology

It is important to understand OpenEdge Management report terminology so that you can be sure you are creating reports based on and containing the kind of data you require.

Remember the following terms as you create OpenEdge Management reports:

- Report History — The history of how a report ran.
Chapter 1: Understanding Reports

- **Report Instance** — The report entity that you schedule to run in order to produce the report result. The report instance identifies specific details that you want reported on; a report instance can specify, for example, a particular resource on which to report or a period of time that the report covers. You specify these report instance details and also schedule when you want the report to run. A report instance is based on a report template.

- **Report Log** — A file where error messages and debug tracing information for a report is written.

- **Report Output** — The formatted data returned when a report instance is run.

- **Report Template** — The report template defines the characteristics of the report. When you want to create a report instance, you begin by selecting the template on which the report is to be based. If you want, you can make changes to some of the properties inherited from the template for a particular report instance so that you get the reporting data you require; for example, you can specify when you want the report to run and what period of time the report should cover. There are template properties that you cannot change in the report instance; for example, you cannot change the type and number of resources in the report or the location in which the report results are written when the report is run.

In summary, to create reports in OpenEdge Management, you use a report template to create a report instance that runs to produce the report output.

### OpenEdge Management report types

OpenEdge Management provides you with a variety of reports on the OpenEdge Management Reports page. You can access them by clicking `Reports > Go to Reports` on the OpenEdge Management console. There are three types of reports:

- **Defined** — Reports based on information in the OpenEdge Management Trend Database. You create instances of these reports using report templates. See Historical report descriptions on page 22 for more information about defined reports.

  You can also view defined reports by clicking `Reports > Report Scheduling > Defined Reports` on the OpenEdge Management console.

- **Realtime** — Reports that show the state of your resources and system at the time the reports are run.

- **Diagnostic** — A report of the OpenEdge Management AdminServer log file, the Work Scheduler, and the Task Scheduler.

OpenEdge Management also supplies a list of report templates and adds any report template you create to this list.

### Report instances

Use any existing report template to create a report instance. See Creating a custom report template on page 47 for details about creating your own template. You access existing report templates from the Create Report page and enter the report instance’s properties on the Report Edit page.

### Create Report page

The Create Report page divides reports into five menu groups:
Additionally, any menu group you create on the Report Template page also appears on the Create Report page. See Creating a custom report template on page 47 for more information about creating menu groups and adding new reports to existing menu groups.

Note: OpenEdge Management supports management of the WebSpeed® Transaction Server product. Throughout this guide, the terms WebSpeed Transaction Server and WebSpeed are used interchangeably.

Report Edit page

The Report Edit page for each report is divided into three sections. While the content of each section varies by report type, certain fields appear on all Report Edit pages:

- The top section includes:
  - **Name** — The name you assign to your report instance.
  - **Description** — A brief description of the report instance.
  - **Resources** — The resource or resources whose information is captured in the report instance.
  - **Output formats** — The format in which you want the report output to appear. See Viewing report output on page 42 for output format examples.
  - **Report format** — The format (Hourly, Daily, Weekly, or Monthly) into which the report's data is arranged.

- The middle section includes:
  - **Report on** one of the following: 15-minute intervals, hourly information, daily information, or weekly information — Indicates how the report output will be structured and is based upon the Report format you choose.
  - **Report Period** — Indicates whether the report instance will cover a previous number of hours, days, weeks, or months or a specific period of days, weeks, or months. The format you select for the report determines the maximum number of periods that the report can include, as shown in the following table:

<table>
<thead>
<tr>
<th>This report format . . .</th>
<th>Shows a maximum of . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>24 hours</td>
</tr>
<tr>
<td>Daily</td>
<td>31 days (7 days if you also select the Report on option)</td>
</tr>
<tr>
<td>Weekly</td>
<td>52 weeks</td>
</tr>
<tr>
<td>Monthly</td>
<td>48 months</td>
</tr>
</tbody>
</table>
• **Time period within the day to include in the report** — Indicates whether the report instance should cover a full day (24 hours) or a partial day.

• **Display units** — The units in which the data is presented. Options are per second, per minute, per hour, per transaction, per record, or as raw data.

• The bottom section includes:

  • **Environment** — Any environment variables. Available environment variables depend on the type of report you are creating and your environment. For a list of environment variables available for your report, run the report with the Generate debug log file option selected. The debug log file lists all environment variables and, if applicable, their values. For more information about viewing environment variables in the debug log file, see the description for Generate debug log file.

  • If the report's output will appear in HTML, you may want to set the GRAPH1COLUMNS or the fathomResourcesPerGraph variables. See Graphical output environment variables on page 29 for more information about these two variables.

  • **Account information** — The user name, group, and password (if you want to run the report as a user other than the AdminServer).

  • **Working directory** — The OpenEdge Management working directory (if you do not want to use the default working directory).

  • **4GL client parameters** — Any additional ABL client startup parameters.

  • **Generate debug log file** — Indicates whether OpenEdge Management will create a trace file when it executes the report instance. Select the check box if you want to create debug log files; otherwise, leave the check box cleared. Creating a debug log file allows you to examine the report's environment variables. When you are viewing the debug log file, you see that lines beginning with env provide the names and values of applicable environment variables.

  For a detailed explanation about environment variables, see the chapter on jobs in *OpenEdge Management: Resource Monitoring*.

### Creating a report instance

The specific steps you follow to create a report instance vary depending on the report's menu group.

To create a report instance:

1. In the management console menu, choose one:

   • Select **Reports > New > Report**.

   • Select **Reports > Go to Reports > Create Report**.

   The Create Report page appears.

2. From the Create Report page, click the type of report you want to create. The Report Edit page for that report type appears.

3. Complete the top section of the Report Edit page, as described in Report Edit page on page 17. Note that certain reports contain unique fields. The following information will help you complete the unique fields:

   • AppServer Application Profile and WebSpeed Application Profile reports include:
<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resources</td>
<td>The resource whose activity you want in the report. Click the right arrow to move a highlighted resource from the Available column to the Selected column. Click the left arrow to move a highlighted resource from the Selected field to the Available field. Click the up and down arrows to change the order in which the resources will appear in the report output.</td>
</tr>
<tr>
<td>Procedure filter</td>
<td>To run a procedure filter, choose Begins With, Literal, or Matches and enter the applicable text in the field. Use the procedure filter to return data about when the broker ran a procedure. When the report instance runs, OpenEdge Management will search the OE_ActBrk table in the OpenEdge Management Trend Database for the text entered.</td>
</tr>
<tr>
<td>Begins with</td>
<td>To use the Begins with filter, type the beginning of the procedure name; for example, inv, inv, or inven.</td>
</tr>
<tr>
<td>Literal</td>
<td>To use the Literal filter, type the exact text you want to find; for example, inventory.p.</td>
</tr>
<tr>
<td>Matches</td>
<td>To use the Matches filter, type the character expression that you want to match (such as .nventory or inven*).</td>
</tr>
<tr>
<td>Note:</td>
<td>The expression can contain wildcard characters. A period (.) indicates that any single character is acceptable in that position and an asterisk (*) indicates that any group of characters is acceptable. To use a literal period or asterisk in the expression, precede the period or asterisk by a tilde (~). You can also use the OR symbol or a vertical line (</td>
</tr>
<tr>
<td>Sort order</td>
<td>The criteria by which the returned procedure data is sorted and whether the data is sorted in descending or ascending order.</td>
</tr>
</tbody>
</table>

- AppServer Performance and WebSpeed Performance reports include:
<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resources</td>
<td>The resource whose activity you want in the report. Click the right arrow to move a highlighted resource from the Available column to the Selected column. Click the left arrow to move a highlighted resource from the Selected column to the Available column. Click the up and down arrows to change the order in which the resources will appear in the report output.</td>
</tr>
<tr>
<td>Data to display</td>
<td>The desired broker activity on which to report: Client, Broker, and/or Server. Click the left arrow to move highlighted text from the Available to the Selected column. Click the right arrow to move highlighted text from the Selected to the Available column. Click the up and down arrows to change the order in which the activity data will appear in the report output.</td>
</tr>
</tbody>
</table>

- Resource Alert Detail, Resource Status Detail, CPU Summary, Network Activity, System Disk Device Activity, System Memory Summary, and all Database menu group reports include:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resources</td>
<td>The resource whose activity you want in the report</td>
</tr>
</tbody>
</table>

4. Complete the middle section of the Report Edit page, described in Report Edit page on page 17. Note that the time interval indicated by the Report format option changes based on the report format chosen, as shown in the following table:

<table>
<thead>
<tr>
<th>This report format</th>
<th>With Report on option selected</th>
<th>Displays the data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>15-minute intervals</td>
<td>Hourly, in four 15-minute intervals</td>
</tr>
<tr>
<td>Daily</td>
<td>Hourly</td>
<td>Daily in hourly increments</td>
</tr>
<tr>
<td>Weekly</td>
<td>Daily</td>
<td>Weekly in daily increments</td>
</tr>
<tr>
<td>Monthly</td>
<td>Weekly</td>
<td>Monthly in weekly increments</td>
</tr>
</tbody>
</table>

5. Complete the bottom section of the Report Edit page, as described in Report Edit page on page 17.

6. Click Save. The name of your report instance appears, along with a summary of the report definition, in the list frame under Defined Reports.

After you create your report instance, you can:

- Click Edit to make changes in the report specifics. When you finish the edits, click Save.
- Click Copy to make a copy of the report specifics, perhaps to use for another report. Type a new name for the report instance, and click Save.
- Click Delete to remove the report instance. Click OK to delete the report instance.

You can either run the report now or schedule it to run at a later time. See Running reports on page 45 for more details.
Historical Reports

Historical reports are created from information in the OpenEdge Management Trend Database.

For details, see the following topics:

- Overview of historical reports
- Historical report descriptions
- Customizing graphical output

Overview of historical reports

Historical reports are created using data from the OpenEdge Management Trend Database.

To see available historical report templates, click Create Report from the OpenEdge Management Reports Details page. The Create Report page appears.

Working with report templates

You can modify or delete any of the existing OpenEdge Management templates, or you can create your own templates. All report templates, regardless of whether they are provided with OpenEdge Management or created, appear in this list of report templates. If you add, delete, or rename a report template, that change is reflected on the Create Report page.
When you create a report template, you provide the template's name, menu group (choose from the existing groups or create your own), and a brief report description that appears on the Create Report page. See Creating a custom report template on page 47 for detailed instructions on creating a report template.

Each of the report templates provided with OpenEdge Management defines reports based on one resource (with the exception of the AppServer and WebSpeed reports, which can report on multiple resources). When you modify the OpenEdge Management-provided report templates or create your own templates, you can choose to generate a report based on multiple resources or resources of different types (database and system CPU in one report, for example).

You can modify or remove any of the individual templates you see listed on the Reports.Report Templates page. This flexibility allows you to set up an OpenEdge Management Reports page that includes only those reports relevant to your business needs.

To delete a report template:
1. Select View Report Templates in the OpenEdge Management Reports page.
2. Click the report template name. The Report Template Summary page appears for that report template.
3. Click Delete and then click Yes to confirm deletion.

The template no longer appears on the Create Report page or in the Reports.Report Templates page.

### Historical report descriptions

When you click the Create Report link on the OpenEdge Management Reports Details page, the Create Report page appears with a list of report templates divided into the following menu groups:

- AppServer reports
- Database reports
- General reports
- System reports
- WebSpeed reports

Any report templates or menu groups you create also appear on the Create Report page.

The following table lists and describes each OpenEdge Management-provided report.

<table>
<thead>
<tr>
<th>Report name</th>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppServer Application Profile</td>
<td>appServerProfile</td>
<td>Provides information on procedures run by the broker, including how many times the procedure ran, the average and maximum durations of each request, the number of successful requests, the number of errors, and the number of times each request quit and was stopped. The AppServer Application Profile report retrieves its data from the OE_ActASProc, OE_ActBrk, OE_ActSrv, and OE_APPService tables in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Report name</td>
<td>Template name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AppServer Performance</td>
<td>appServerPerformance</td>
<td>Provides performance information on broker, client, and server activity. Broker activity information returned includes number of complete requests, number of queued requests, percentage of queued requests, average and maximum request duration, average and maximum CPU use, and average and maximum memory use. Client activity information returned includes average and maximum number of active clients, and average and maximum number of client requests. Server activity information returned includes average and maximum CPU pool use, average and maximum memory pool use, average and maximum number of busy servers, average and maximum number of running servers, and average and maximum number of locked servers. The AppServer Performance report retrieves its data from the OE_ActBrk, OE_ActSrv, OE_APPService, and Sys_Process tables in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database After-imaging</td>
<td>dbAfterImage</td>
<td>Provides performance details for after-imaging, including read and write activity, full and partial buffer activity, and AIW write status. The Database After-imaging report retrieves its data from the Db_ActLog in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database Area Status</td>
<td>dbAreaStatus</td>
<td>Provides trend status for each area within a database. Included in this report is information about total blocks, the high water mark, free blocks, available space (in blocks), and available space as a percentage of area. The Database Area Status report retrieves its data from the DB_AreaStatus table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database Before-imaging</td>
<td>dbBeforeImage</td>
<td>Provides performance details for before-imaging, including read and write activity; wait activity; full, partial, and empty buffer activity; and BIW statistics. This report also helps you determine the health of your BI subsystem by indicating increases in the amount of BI writes (which can indicate the growth of an application or questionable application design). The Database Before-imaging report retrieves its data from the Db_ActLog and Db_ActIOType tables in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Report name</td>
<td>Template name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Database Buffer I/O</td>
<td>dbMemory</td>
<td>Provides details about memory buffer usages for all buffers (database, BI, and AI). The information provided in the Database Buffer I/O report helps you determine the proper use of OpenEdge memory on your machine. This report retrieves its data from the Db_ActBuf and Db_ActLog tables in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database Checkpointing</td>
<td>dbCheckpoint</td>
<td>Provides performance details for checkpoints. The Database Checkpointing report retrieves its data from the Db_Checkpoint table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database Details</td>
<td>dbDetail</td>
<td>Provides information on all database tables and includes fields from almost every table, depending on relevance. Use this report to gather cross-functional information and to understand the relationship among different aspects of an OpenEdge database. The Database Details report retrieves information from the following OpenEdge Management Trend Database tables: Db_ActBuf, Db_ActRec, Db_ActLog, Db_ActAPW, Db_ActIdx, Db_ActLock, Db_ActSum, and Db_ActIOType.</td>
</tr>
<tr>
<td>Database Disk Information</td>
<td>dbDisk</td>
<td>Provides performance details for database reads and writes to disk, including database read and write activity, BI file, AI file, and index reads and writes. This report helps you track the growth of your database and predict when you need more throughput. The Database Disk Information report retrieves its data from the Db_ActSum, Db_ActAPW, and Db_ActIOType tables in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database Index Analysis</td>
<td>dbIDXAnalysis</td>
<td>Provides analysis of index information gathered from the execution of the database analysis job. Information provided in this report includes the maximum, minimum, and average of the number of blocks in the index, the number of bytes in the index, utilization percentage of the block space, and the number of index levels in the index. The Database Index Analysis report retrieves its information from the Db_IdxAnalysis table.</td>
</tr>
</tbody>
</table>

**Note:** In order for the Database Index Analysis report to display data, the Database Analysis job must first be run against the desired database. For more information on the Database Analysis job, see *OpenEdge Management: Database Management.*
<table>
<thead>
<tr>
<th>Report name</th>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Index Usage</td>
<td>dbIndexStat</td>
<td>Provides performance details for each index in the schema, including the number of updates, creates, deletes, and blocks returned to the free chain. By showing which of your indexes are most active, this report helps you determine the structure of your database areas and where to place indexes. Combining the information presented in this report with that presented in the Database Table Usage report gives you a complete picture of database activity. The Database Index Utilization report retrieves its data from the Db_IndexStat table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database Locking</td>
<td>dbLocks</td>
<td>Provides performance details for record locking, based on the categories of requests, finds, locks, and waits. Each of the four categories contains information about exclusive, record, share, and upgrade locks. The Database Locking report retrieves its data from the Db_ActLock table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database Record Information</td>
<td>dbRecord</td>
<td>Provides performance details for record locking, including information on increased record update activity, increased fragment activity, and increased record deletion. This report groups information into three categories: record, fragment, and bytes. Each category contains read, update, create, and delete fields. The Database Record Information report retrieves its data from the Db_ActRec table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Database Server Activity</td>
<td>dbServer</td>
<td>Provides detailed information about client activity on servers, including I/O for the server in bytes, records, and blocks. This report helps you assess the performance of your servers by showing how balanced or unbalanced the server activity is. The Database Server Activity report retrieves its information from the Db_ActServer table in the OpenEdge Management Trend Database.</td>
</tr>
</tbody>
</table>

**Note:** OpenEdge Management reports on a default of 50 tables. Use the startup parameter -idxrangesize to increase this number, if necessary. This parameter must be set on the production database when it is started.
<table>
<thead>
<tr>
<th>Report name</th>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Summary</td>
<td>dbSummary</td>
<td>Provides a summary of performance information for several subsections of a database, including logical and physical I/O, buffer activity, BI file activity, AI file activity, page writer activity, index I/O, table I/O, and record activity. The Database Summary report retrieves its data from the following OpenEdge Management Trend Database tables: Db_ActBuf, Db_ActSum, Db_ActRec, Db_ActLog, Db_ActAPW, Db_ActIdx, and Db_ActIOType.</td>
</tr>
</tbody>
</table>
| Database Table Analysis     | dbTabAnalysis | Provides analysis of table information gathered from the execution of the database analysis job. This report includes the maximum, minimum, and average for the record counts, the number of bytes in the table, the number of record fragments in the table, and the scatter factor. The Database Table Analysis report retrieves its data from the Db_TabAnalysis table.  

**Note:** In order for the Database Table Analysis report to display data, the Database Analysis job must first be run against the desired database. For more information on the Database Analysis job, see *OpenEdge Management: Database Management*.  |
| Database Table Usage        | dbTableStat   | Provides performance details for each table in the schema, including information related to the number of table updates, creates, and deletes. This report identifies which tables are the most active, allowing you to better structure your database areas by moving tables. The Database Table Utilization report retrieves its data from the Db_TableStat table in the OpenEdge Management Trend Database.  

**Note:** OpenEdge Management reports on a default of 50 tables. Use the startup parameter -tablerangesize to increase this number, if necessary. This parameter must be set on the production database when it is started. |
<table>
<thead>
<tr>
<th>Report name</th>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Alert Detail</td>
<td>alertIndividual</td>
<td>Provides summary and detail information for alerts specific to a resource, including counts of the different types of alerts that have occurred, details of all severe alerts, and data entered when the alert was cleared. The Resource Alert Detail report retrieves its data from the Cf_Alert_Detail table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Resource Alert Summary</td>
<td>alertGeneral</td>
<td>Provides summary information about a site's alerts, including information sorted by the resource name. This report shows which of a site's resources cause the most problems. The Resource Alert Summary report retrieves its data from the Cf_Alert_Detail table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Resource Status Detail</td>
<td>statusDetail</td>
<td>Provides a detail of status states for a resource. This report provides information that includes a category for each status change reported in the time frame chosen. Also, there are specific details for each status change within the database. The Resource Status Detail report retrieves its information from the Cf_Status table.</td>
</tr>
<tr>
<td>Resource Status Summary</td>
<td>statusSummary</td>
<td>Provides a summary of status states for all resources. This report provides information that includes a category for each status reported in the time frame chosen. The Resource Status Summary report retrieves its data from the Cf_Status table.</td>
</tr>
<tr>
<td>CPU Summary</td>
<td>systemCPU</td>
<td>Provides a summary of the defined CPU resource's performance. This report helps you track how well the CPU works, the different areas it works in, and how often it works in each area. Use the information from this report to identify growth in CPU usage over time. The CPU Summary report retrieves its data from the Sys_CPU table in the OpenEdge Management Trend Database.</td>
</tr>
</tbody>
</table>

**Note:** If run for a multi-CPU system, this report returns information based on all the CPUs together. For further information on individual CPUs, refer to the appropriate vendor's information.
<table>
<thead>
<tr>
<th>Report name</th>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Summary</td>
<td>fileSummary</td>
<td>Provides size information about the defined file monitor. This report shows the average of the file size over the period being reported. Use this report to check the size of ASCII-based text files. This report does not typically deal with variable-length extents. The File Size Summary report retrieves its information from the Sys_FileSize table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Network Activity</td>
<td>network</td>
<td>Provides status summaries for the defined network resource, including the count of statuses received during the report period as well as the average response time of tests. Use the information in this report to monitor and flag potential network bottlenecks.</td>
</tr>
<tr>
<td>System Disk Device Activity</td>
<td>systemDisk</td>
<td>Provides performance information for defined disk devices, including the relationship between disk reads and writes and the average queue length of disk activity. Use this report to identify disk bottlenecks and a decline in disk performance. The System Disk Device Activity report retrieves its data from the Sys_Dev table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>System Filesystem Usage</td>
<td>systemFileSystem</td>
<td>Provides usage information for defined local or remote file systems, including how fast disk space grows from all software (including OpenEdge). Use this report to debug actual or potential file space problems where OpenEdge temporary files reside. The System Filesystem Usage report retrieves its data from the Sys_Filesys table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>System Memory Summary</td>
<td>systemMemory</td>
<td>Provides a summary of the defined memory resource's performance. By detailing how much memory is used and how much is available, this report helps identify growth in memory consumption. Combining the information in this report with that of the Database Buffer I/O report provides views of memory from the standpoint of both the system and OpenEdge. The System Memory Summary report retrieves this information from the Sys_Mem table in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>Report name</td>
<td>Template name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>WebSpeed Application Profile</td>
<td>webSpeedProfile</td>
<td>Provides information on procedures run by the broker, including how many times the procedure ran, the average and maximum durations of each request, the number of successful requests, the number of errors, and the number of times each request stopped. The WebSpeed Application Profile report retrieves its data from the OE_ActWSProc, OE_ActBrk, OE_ActSrv, and OE_APPService tables in the OpenEdge Management Trend Database.</td>
</tr>
<tr>
<td>WebSpeed Performance</td>
<td>webSpeedPerformance</td>
<td>Provides performance information on broker, client, and agent activity. Broker activity information returned includes number of complete requests, number of queued requests, percentage of queued requests, average and maximum request duration, average and maximum CPU use, and average and maximum memory use. Client activity information returned includes average and maximum number of active clients and average and maximum number of client requests. Server activity information returned includes average and maximum CPU pool use, average and maximum memory pool use, average and maximum number of busy servers, average and maximum number of running servers, and average and maximum number of locked servers. The WebSpeed Performance report retrieves its data from the OE_ActBrk, OE_ActSrv, OE_APPService, and Sys_Process tables in the OpenEdge Management Trend Database.</td>
</tr>
</tbody>
</table>

For more information about OpenEdge Management Trend Database tables, see *OpenEdge Management: Trend Database Guide and Reference*.

## Customizing graphical output

Each historical report is designed to display data in both graphical and tabular formats. You can customize the data displayed in the HTML graph report output. To do so, you must set the proper environment variable and identify the specific report fields or column headings that you want to include in the graph output.

See *Graphical output environment variables* on page 29 for more information about the two environment variables that affect graphical output. See *Report output field and column headings* on page 32 for the field and column headings.

## Graphical output environment variables

There are two environment variables that control how graphs display in HTML report output:
• **GRAPH1COLUMNS** — Used with report output associated with either a single resource or multiple resources. For example:

  - For instances reporting on single resources, GRAPH1COLUMNS controls the number of columns displayed in the graph. For example, most historical reports are designed to display graphical data in HTML output associated with report-related default fields. However, by adding the variable GRAPH1COLUMNS followed by other fields associated with a report, you can customize the graphic report output. See Single resource output on page 30 for an example.

  - For instances reporting on multiple resources, GRAPH1COLUMNS controls the number of graphs displayed. The output will contain one graph for each output category you indicate. Always enter the names of the output categories in quotes.

• **fathomResourcesPerGraph** — Used with report instances that report on multiple resources. This variable controls the number of resources displayed in each graph. The default number of resources displayed is five.

**Note:** Only AppServer and WebSpeed reports allow you to report on multiple resources.

---

**Single resource output**

The following figure is an example of the type of graph that appears when you run the CPU Summary report without GRAPH1COLUMNS defined. In instances when you do not choose to define environment variables in the Environment field on the Create Report page, OpenEdge Management creates a report graph using the values associated with a report type's default fields.

The graph report output example in the following figure uses the values associated with the CPU Summary report's default fields.

**Figure 1: CPU Summary output**

In contrast, the following code entered in the Environment field on the Create Report page shows how you can customize the graph output of the report by defining a field:

```
GRAPH1COLUMNS=CPU_Idle
```
When the CPU Summary report is run with this code, the data associated with the specified field appears. The following figure shows this customized output.

**Figure 2: Customized graph output for CPU Summary**

![CPU Summary Graph](image)

See [Report output field and column headings](#) on page 32 for a complete list of the column and field headings available for each report template.

### Multiple resources output

The following figure shows an example of the type of graph that displays when you run the AppServer Application Profile report without the GRAPH1COLUMNS or the fathomResourcesPerGraph defined. In instances when you do not choose to define environment variables in the Environment field in the Create Report page, OpenEdge Management creates a report graph using the values associated with a report type’s default fields.

The graph report output example in the following figure uses the values associated with the AppServer Application Profile report’s default fields.

**Figure 3: AppServer Application Profile output**

![AppServer Profile Graph](image)

In contrast, the following information entered in the Environment field on the Create Reports page shows how you can customize the graph output of the report by defining:

- Column headings for GRAPH1COLUMNS
- Number of resources to display per graph for fathomResourcesPerGraph
When the AppServer Application Profile report is run with the following code, only the column heading-related data, with the specified number of resources per graph, appears:

```
GRAPHICCOLUMNS="Run Count,Request Duration (avg),Return Code Success"
fathomResourcesPerGraph="7"
```

The following figures show this customized output.

**Figure 4: Request duration graph**

![Request duration graph]

**Figure 5: Return code success graph**

![Return code success graph]

**Figure 6: Run count graph**

![Run count graph]

**Report output field and column headings**

This section identifies the fields or column headings associated with each historical report template.

**Note:** Fields and column headings in this section that are identified with an asterisk (*) are also the OpenEdge Management-supplied defaults associated with each report type.

**AppServer Application Profile**

The following table identifies the AppServer Application Profile column headings.
Table 2: AppServer Application Profile column headings

<table>
<thead>
<tr>
<th>Run Count*</th>
<th>Request Duration (avg)</th>
<th>Request Duration (max)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Code Success</td>
<td>Return Code Error</td>
<td>Return Code Quit</td>
</tr>
<tr>
<td>Return Code Stop</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

AppServer Performance
The following tables identify the column headings for an AppServer Performance graphical report.

Table 3: AppServer Client Activity column headings

<table>
<thead>
<tr>
<th>Average Active Clients*</th>
<th>Maximum Active Clients</th>
<th>Client Requests</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Client Requests</td>
<td>Maximum Client Requests</td>
<td>Sample Count</td>
</tr>
</tbody>
</table>

Table 4: AppServer Broker Activity column headings

<table>
<thead>
<tr>
<th>Requests Completed</th>
<th>Requests Queued</th>
<th>Requests Queued %</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Average Request Duration (ms)</td>
<td>Average CPU Usage %</td>
<td>Maximum CPU Usage %</td>
</tr>
<tr>
<td>Average Memory Usage (KB)</td>
<td>Maximum Memory Usage (KB)</td>
<td>Sample Count</td>
</tr>
</tbody>
</table>

Table 5: AppServer Activity column headings

<table>
<thead>
<tr>
<th>Average Pool CPU Usage %</th>
<th>Maximum Pool CPU Usage %</th>
<th>Average Pool Memory Usage (KB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Memory Usage (KB)</td>
<td>*Average Busy Server Count</td>
<td>Maximum Busy Server Count</td>
</tr>
<tr>
<td>Average Busy Server Time (ms)</td>
<td>Average Locked Server Count</td>
<td>Maximum Locked Server Count</td>
</tr>
<tr>
<td>Average Locked Server Time (ms)</td>
<td>Sample Count</td>
<td>—</td>
</tr>
</tbody>
</table>

Database After-imaging
The following table identifies the column headings for a Database After-Imaging graphical report.

Table 6: Database After-Imaging column headings

<table>
<thead>
<tr>
<th>AI Busy Buffer Waits</th>
<th>AI Bytes Written</th>
<th>AI No Buffers Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>AI Partial Writes</td>
<td>AI Records Written</td>
<td>Total AI Writes*</td>
</tr>
<tr>
<td>AIW AI Writes*</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Database Area Status
The following table identifies the column headings for a Database Area Status graphical report.
Table 7: Database Area Status column headings

<table>
<thead>
<tr>
<th>Sample Count</th>
<th>Total Blocks</th>
<th>Hi Water Mark*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Blocks</td>
<td>RM Blocks</td>
<td>Blocks Available*</td>
</tr>
<tr>
<td>Pct. Blocks Available</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Database Before-imaging
The following table identifies the fields for a Database Before-Imaging graphical report.

Table 8: Database Before-Imaging fields

<table>
<thead>
<tr>
<th>BI Busy Buffer Waits</th>
<th>BI Bytes Read</th>
<th>BI Bytes Written</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Empty Buffer Waits</td>
<td>BI Partial Writes</td>
<td>BI Records Read</td>
</tr>
<tr>
<td>BI Records Written</td>
<td>Total BI Reads</td>
<td>Total BI Writes</td>
</tr>
<tr>
<td>BIW BI Writes</td>
<td>BI Reads</td>
<td>BI Writes</td>
</tr>
</tbody>
</table>

Database Checkpointing
The following table identifies the column headings for a Database Checkpointing graphical report.

Table 9: Database Checkpointing column headings

<table>
<thead>
<tr>
<th>Sample Count</th>
<th>Avg. Checkpoint Length (sec.)*</th>
<th>Avg. Buffer Scanned</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg. Buffers on Ckpt Queue</td>
<td>Avg Buffers on APW Queue</td>
<td>Avg Buffers Flushed at Ckpt*</td>
</tr>
</tbody>
</table>

Database Details
The following table identifies the fields for a Database Details graphical report.

Table 10: Database Details fields

<table>
<thead>
<tr>
<th>APW Queues</th>
<th>APW Queue Writes</th>
<th>Buffers Checkpointed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buffers Scanned</td>
<td>Checkpoint Queue Writes</td>
<td>Checkpoints</td>
</tr>
<tr>
<td>APW DB Writes</td>
<td>Marked at Checkpoint</td>
<td>Scan Cycles</td>
</tr>
<tr>
<td>Scan Writes</td>
<td>Total DB Writes</td>
<td>Writes Deferred</td>
</tr>
<tr>
<td>Flushed at Checkpoint</td>
<td>Logical Reads</td>
<td>Logical Writes</td>
</tr>
<tr>
<td>O/S Reads</td>
<td>O/S Writes</td>
<td>Create Index Entry</td>
</tr>
<tr>
<td>Delete Index Entry</td>
<td>Find Index Entry</td>
<td>Free Block</td>
</tr>
</tbody>
</table>
### Database Disk Information

The following table identifies the fields for a Database Disk Information graphical report.

<table>
<thead>
<tr>
<th>Table 11: Database Disk Information fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Count</td>
</tr>
<tr>
<td>Buffer Writes</td>
</tr>
<tr>
<td>Unbuffered Reads</td>
</tr>
</tbody>
</table>
Database Index Analysis

The following table identifies the column headings for a Database Index Analysis graphical report.

**Table 12: Database Index Analysis column headings**

<table>
<thead>
<tr>
<th>Sample Count</th>
<th>Max Block Count</th>
<th>Avg Block Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Byte Count</td>
<td>Avg Byte Count</td>
<td>Max Util Percent</td>
</tr>
<tr>
<td>Avg Util Percent*</td>
<td>Max Level Count</td>
<td>Avg Level Count</td>
</tr>
</tbody>
</table>

Database Index Usage

The following table identifies the column headings for a Database Index Usage graphical report.

**Table 13: Database Index Utilization column headings**

<table>
<thead>
<tr>
<th>Index Reads*</th>
<th>Index Splits</th>
<th>Index Creates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Deletes</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Database Locking

The following table identifies the fields for a Database Locking graphical report.

**Table 14: Database Locking fields**

<table>
<thead>
<tr>
<th>Requests Canceled</th>
<th>Downgrade</th>
<th>Excl Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclusive Locks</td>
<td>Exclusive Requests</td>
<td>Exclusive Waits</td>
</tr>
<tr>
<td>Rec Get Grants</td>
<td>Rec Get Requests</td>
<td>Rec Get Waits</td>
</tr>
<tr>
<td>Shr Release</td>
<td>Share Locks</td>
<td>Share Requests</td>
</tr>
<tr>
<td>Share Waits</td>
<td>Upgrade Locks</td>
<td>Upgrade Requests</td>
</tr>
<tr>
<td>Upgrade Waits</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Database Buffer I/O

The following table identifies the fields for a Database Buffer I/O graphical report.

**Table 15: Database Buffer I/O fields**

<table>
<thead>
<tr>
<th>Writes Deferred</th>
<th>Flushed at Checkpoint</th>
<th>Logical Reads</th>
</tr>
</thead>
<tbody>
<tr>
<td>O/S Reads</td>
<td>AI Busy Buffer Waits</td>
<td>AI No Buffers Available</td>
</tr>
</tbody>
</table>
### Database Record Information
The following table identifies the fields for a Database Record Information graphical report.

**Table 16: Database Record Information fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Field</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes Created</td>
<td>Bytes Deleted</td>
<td>Bytes Read</td>
</tr>
<tr>
<td>Bytes Updated</td>
<td>Fragments Created</td>
<td>Fragments Deleted</td>
</tr>
<tr>
<td>Fragments Read</td>
<td>Fragments Updated</td>
<td>Create Record</td>
</tr>
<tr>
<td>Delete Record</td>
<td>Record Locks</td>
<td>Read Record</td>
</tr>
<tr>
<td>Update Record</td>
<td>Record Waits</td>
<td>—</td>
</tr>
</tbody>
</table>

### Database Server Activity
The following table identifies the column headings for a Database Server Activity graphical report.

**Table 17: Database Server Activity column headings**

<table>
<thead>
<tr>
<th>Column</th>
<th>Column</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages Received</td>
<td>Messages Sent</td>
<td>Bytes Received</td>
</tr>
<tr>
<td>Bytes Sent</td>
<td>Records Received*</td>
<td>Records Sent*</td>
</tr>
<tr>
<td>Min Users</td>
<td>Max Users</td>
<td>Avg Users</td>
</tr>
</tbody>
</table>

### Database Summary
The following table identifies the fields for a Database Summary graphical report.

**Table 18: Database Summary fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Field</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buffers Checkpointed</td>
<td>Flushed at Checkpoint</td>
<td>Logical Reads</td>
</tr>
<tr>
<td>Logical Writes</td>
<td>O/S Reads</td>
<td>O/S Writes</td>
</tr>
<tr>
<td>Create Index Entry</td>
<td>Delete Index Entry</td>
<td>Find Index Entry</td>
</tr>
<tr>
<td>Free Block</td>
<td>Remove Locked Entry</td>
<td>Split Block</td>
</tr>
<tr>
<td>DB Data Block Reads</td>
<td>DB Index Block Reads</td>
<td>Index Block Writes</td>
</tr>
<tr>
<td>Total BI Writes</td>
<td>BIW BI Writes</td>
<td>Read Record</td>
</tr>
</tbody>
</table>
Database Table Analysis

The following table identifies the column headings for a Database Table Analysis graphical report.

Table 19: Database Table Analysis column headings

<table>
<thead>
<tr>
<th>Sample Count</th>
<th>Max Record Count</th>
<th>Avg Record Count*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max # of Bytes</td>
<td>Avg # of Bytes</td>
<td>Max # of Fragments</td>
</tr>
<tr>
<td>Avg # of Fragments</td>
<td>Max Scatter Factor</td>
<td>Avg Scatter Factor</td>
</tr>
</tbody>
</table>

Database Table Usage

The following table identifies the column headings for a Database Table Usage graphical report.

Table 20: Database Table Usage column headings

<table>
<thead>
<tr>
<th>Record Reads*</th>
<th>Record Updates*</th>
<th>Record Creates*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Deletes*</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

CPU Summary

The following table identifies the fields for a CPU Summary graphical report.

Table 21: CPU Summary fields

<table>
<thead>
<tr>
<th>User Percent*</th>
<th>System Percent*</th>
<th>Wait Percent*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle Percent</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

File Summary

The following table identifies the column headings for a File Summary graphical report. (Note that you must have at least one file resource for OpenEdge Management to generate the report.)

Table 22: File Summary column headings

<table>
<thead>
<tr>
<th>Sample Count</th>
<th>Average File Size (k)*</th>
<th>Minimum File Size (k)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum File Size (k)</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>
**Network Activity**

The following table identifies the column headings for a Network Activity graphical report.

**Table 23: Network Activity column headings**

<table>
<thead>
<tr>
<th>Passed Sample Count</th>
<th>Average Response Time (ms)</th>
<th>Failed Sample Count</th>
</tr>
</thead>
</table>

**System Disk Device Activity**

The following table identifies the column headings for a System Disk Device Activity graphical report.

**Table 24: System Disk Device Activity column headings**

<table>
<thead>
<tr>
<th>Sample Count</th>
<th>Pct. Busy*</th>
<th>Avg. Queue Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Busy Pct.</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

**System Filesystem Usage**

The following table identifies the column headings for a System Filesystem Usage graphical report.

**Table 25: System Filesystem Usage column headings**

<table>
<thead>
<tr>
<th>Sample Count</th>
<th>Maximum Capacity (kb)</th>
<th>Pct. Used*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Available (kb)</td>
<td>Maximum Available (kb)</td>
<td>Minimum Available (kb)</td>
</tr>
</tbody>
</table>

**System Memory Summary**

The following table identifies the column headings for a System Memory Summary graphical report.

**Table 26: System Memory Summary column headings**

<table>
<thead>
<tr>
<th>Sample Count</th>
<th>Average Physical Memory Used %</th>
<th>Average Physical Memory Used (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Physical Memory Used (MB)</td>
<td>Average Virtual Memory Used %</td>
<td>Average Virtual Memory Used (MB)</td>
</tr>
<tr>
<td>Maximum Virtual Memory Used (MB)</td>
<td>Pages In</td>
<td>Pages Out</td>
</tr>
</tbody>
</table>

**WebSpeed Application Profile**

The following table identifies the column headings for a WebSpeed Application Profile graphical report.
### Table 27: WebSpeed Application Profile column headings

<table>
<thead>
<tr>
<th>Run Count*</th>
<th>Average Request Duration (ms)</th>
<th>Maximum Request Duration (ms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Count</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

### WebSpeed Performance

The following tables identify the column headings for a WebSpeed Performance graphical report.

### Table 28: WebSpeed Client Activity column headings

<table>
<thead>
<tr>
<th>Average Active Clients*</th>
<th>Maximum Active Clients</th>
<th>Client Requests</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Client Requests</td>
<td>Maximum Client Requests</td>
<td>Sample Count</td>
</tr>
</tbody>
</table>

### Table 29: WebSpeed Broker Activity column headings

<table>
<thead>
<tr>
<th>Requests Completed</th>
<th>Requests Queued</th>
<th>Requests Queued %</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Average Request Duration (ms)</td>
<td>Average CPU Usage %</td>
<td>Maximum CPU Usage %</td>
</tr>
<tr>
<td>Average Memory Usage (KB)</td>
<td>Maximum Memory Usage (KB)</td>
<td>Sample Count</td>
</tr>
</tbody>
</table>

### Table 30: WebSpeed Server Activity column headings

<table>
<thead>
<tr>
<th>Average Pool CPU Usage %</th>
<th>Maximum Pool CPU Usage %</th>
<th>Average Pool Memory Usage (KB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Memory Usage (KB)</td>
<td>*Average Busy Server Count</td>
<td>Maximum Busy Server Count</td>
</tr>
<tr>
<td>Average Busy Server Time (ms)</td>
<td>Average Locked Server Count</td>
<td>Maximum Locked Server Count</td>
</tr>
<tr>
<td>Average Locked Server Time (ms)</td>
<td>Sample Count</td>
<td>—</td>
</tr>
</tbody>
</table>
Working with Report Instances

Once you create a report instance, you can run the report immediately or schedule it to run at a later time. You can also view information about all scheduled, completed, or running reports.

For details, see the following topics:

- Scheduling reports to run
- Viewing report output
- Viewing report history
- Scheduled reports
- Completed reports
- Running reports

Scheduling reports to run

A report instance will not run until you tell OpenEdge Management to run it immediately or you schedule it.

To run a report immediately:

1. If the report's Summary page is not displayed, choose the report from the Defined Reports page. The Summary page appears.

2. From the Summary page, click Run Now. A message appears acknowledging your report request.

After you run the report, you can view the output by clicking View Last Output File. See the Viewing report output on page 42 for more information.
To schedule a report to run at another time:

1. If the report's Summary page is not displayed, choose the report from the Defined Reports option. The Summary page appears.
2. From the Summary page, click Schedule. The Report Schedule page appears.
3. Choose a start date and time.
4. Determine the repeat interval: One time, At startup, Weekly from date, Monthly from date, Every 5 minutes, Every 15 minutes, Every 30 minutes, Every 60 minutes, Daily, or Cron expression.

Use cron-based scheduling when you need a report to run at a specific time, such as according to a business period interval (on the last Friday of the month, or every ten minutes from 4 P.M. to 6 P.M. daily, for example).

You can include from one to five cron expressions (separated by semi-colons) in the Cron expression field in a job schedule. Once you click in the Cron Expression field, you can click Assist for help in choosing the month, day, date, etc., which will then be translated into cron expression format for you.

For more details about using cron expressions, click the Cron expression field Help button or see the chapter on jobs in OpenEdge Management: Resource Monitoring.
5. Select which days to include.
6. Select the Enabled check box (if it is not already selected).
7. Click Save.

After the report's scheduled run, you can view the output by clicking View Last Output File from the Summary page.

### Viewing report output

After you run a report, you can view:

- The last output file for the report
- A list of output files for the report
- The history of the report

To view the last output file generated for a report:

1. If the report's Summary page is not displayed, choose the report from the Defined Reports page. The Summary page appears.
2. Click View Last Output File. The report opens.
3. Use the scroll bar to review the output, or choose File > Print if you want a hard copy version.

The details that the report supplies depend on the type of report you are running.

**Note:** Some reports include a category called Change Pct. If the difference between the first set of data and the last set of data is more than 20%, the change percentage is shown in the report. If the change is less than 20%, the column is empty.

To see a list of all output files for a report:
1. If the report's Summary page is not displayed, choose the report from the Defined Reports page. The Summary page appears.

2. Click List of Report Output Files. The Completed Reports page appears with a list of the reports that have been created.

The following table describes the files that appear on the Completed Reports page:

<table>
<thead>
<tr>
<th>Files with this extension</th>
<th>Contain the report . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>.err</td>
<td>Errors</td>
</tr>
<tr>
<td>.html</td>
<td>Output in HTML format</td>
</tr>
<tr>
<td>.log</td>
<td>Debugging information (OpenEdge Management creates a debug log file when you select the Generate debug log file check box on the Report Edit page.)</td>
</tr>
<tr>
<td>.out</td>
<td>Status</td>
</tr>
<tr>
<td>.txt</td>
<td>Output in text format</td>
</tr>
<tr>
<td>.xml</td>
<td>Output in xml format, with debugging information</td>
</tr>
</tbody>
</table>

The most recently created files appear first.

Note: If a report is scheduled to run frequently, the list of output files can grow large.

3. Select the desired report file and click View. The display of report output depends on the report run and whether you chose to view the text or HTML file.

To delete a report output file:
1. Navigate to the Completed Reports page.
2. Select the output file you want to delete.
3. Click Delete.

Viewing report history

Once a report instance has run, you can view summary information about it. OpenEdge Management displays the following information for each completed report instance:

- The report name
- The start time (when the report began running)
- The end time (when the report finished running)
- The exit code

A report's exit code indicates whether or not the process succeeded. Typically, an exit code of zero indicates success, while a nonzero code indicates an error. For more information on nonzero exit codes, search the log file. If a report running in Windows returns a positive, nonzero code, use the \texttt{net helpmsg} command for information.
To view a report’s history:

1. If the report’s Summary page is not displayed, in the management console menu choose the report by either:
   - Selecting Reports > Report Scheduling > Defined Reports.
   - Selecting Reports > Go to Reports > View Report History.

The Report History page appears.

2. In the Report History query section, select the range of dates in the From and To fields.

3. Click Submit. The report’s history appears on the bottom of the Report History page.

---

Note: The previous steps show how to access the history of a single report. For the history of all reports run, click View Report History from the OpenEdge Management Reports page (shown in Figure 1). Continue from Step 2 in the previous procedure. The query returns results for any reports run during the date range.

To remove a report’s history, follow the previous steps. After submitting the query dates, click Purge Selection. Once you purge a selection, you can no longer access the report’s history for that time frame.

## Scheduled reports

Use the Scheduled Reports page to track all scheduled report instances.

To view a list of reports that are scheduled to run:

1. In the management console menu, choose one of the following:
   - Select Reports > Report Scheduling > Scheduled Reports.
   - Select Reports > Go to Reports > View Scheduled Reports.

The Scheduled Reports page appears.

2. Click a report name to go to the report’s Summary page.

If an expected report instance does not appear on the Scheduled Reports page, make sure the Enabled box is checked on that report’s Edit page. Only enabled reports appear in the Scheduled Reports list.

## Completed reports

Use the Completed Reports page to track which reports have run.

To view reports that have completed running, in the management console menu, choose one of the following:

- Select Reports > Report Scheduling > Completed Reports.
- Select Reports > Go to Reports > View Completed Reports

A list of reports already run appears.

Note that each report is listed under its corresponding resource type, report name, and occurrence.

To view a report, select it and click View.
To delete a report, select it and click **Delete**. Click **Yes** to confirm the deletion.

**Note:** Deleting reports from the **Report Viewer** removes the report output file. It does not delete the report's data from the OpenEdge Management Trend Database.

---

**Running reports**

The **Running Reports** page displays the following details about each report:

- The report name
- The process ID
- The start time (when the report began running)
- The command executed to run the report
- Any parameters you defined for the command

To view a list of reports that are currently running, in the management console menu, choose one of the following:

- Select **Reports > Report Scheduling > Running Reports**.
- Select **Reports > Go to Reports > View Running Reports**

Clicking a report name brings you to the report's **Summary** page.
Creating Custom Report Templates

Using OpenEdge Management, you can create your own report templates or modify any of the supplied templates. Once you edit a report template (or create your own), you need not re-enter the criteria each time you want to create a report instance.

For details, see the following topics:

- Creating a custom report template
- Editing the report template
- Copying the report template
- Deleting the report template
- Importing and exporting report templates

Creating a custom report template

You specify each OpenEdge Management report template's properties and characteristics on two pages. The first template page defines the properties that are related to the type of report. You cannot change these properties in the instances you create from the template. On the second page, you provide default values for the report instances. These values, such as the schedule, can be changed.

To create a report template:

1. In the management console menu, choose one of the following:
   - Select Reports > New > Report Template.
Chapter 4: Creating Custom Report Templates

- Select Reports > Go to Reports > Create Report Template.

The first of two Report Template pages appears. This first page consists of a Template Properties box divided into four sections. The first two sections are shown:

2. You must provide the following information:
   a) In the Name field, enter the report template name. Note that the name must be unique among the report templates. Note also that spaces are not allowed in the name fields on this page.
   b) In the Menu group field, enter the name of the new menu group, or choose an existing menu group in the Existing field. (When you choose an existing group, the name automatically appears in the Menu group field.) The menu group is the heading under which the report template name appears (for example, Database Reports).
   c) In the Menu entry field, enter the template name you want to appear on the Custom Create Trend Report page (for example, Database Monthly Report).
   d) In the Menu description field, enter a brief description of the report template. This is the description that appears in the list of available report templates on the Create Custom Trend Report page under the name specified in Step c.

3. Continue to the third section of the Template Properties box:

Under Source of eligible resources, choose one of the following:
• **Resources currently defined on the system** — Only those resources, such as databases, defined for an AdminServer. This is the default that all OpenEdge Management-provided report templates use, unless you modify the template to change it.

• **Local resources in the trend database** — Information obtained from whatever is in the local trend database. This might include resources no longer on your machine; information can be gathered from historical records.

  **Note:** Use this option only if you are trending locally.

• **All resources in the trend database** — This includes local resources as well as resources that are not local but are trending to the trend database. The report instance will display choices such as the AdminServer name and the resource name. Selection lists for each site will be added to the page.


   Highlight a type, then click the right arrow to move it to the **Selected** column. To remove a type from the **Selected** column, highlight the type and then click the left arrow.

   When creating a template for an AppServer or WebSpeed resource, indicate if the report should be a performance or profile report.

5. Under **Limit how many resources can be included in the report**, select how many database resources and how many total resources the report instance is allowed to select. You can choose up to three in each field. (Keep in mind that the All resources field includes databases.)

6. Continue to the fourth section of the **Template Properties** box:

   a) In the **Progress 4GL program to run** field, enter the path to the ABL (formerly known as Progress 4GL) program to run when this report is scheduled.

   When you create a report by using any one of the OpenEdge Management report templates, the particular ABL program that you use to run the report is provided in the `<OpenEdgeManagement-install-dir>/src` directory. (The default installation location is `Progress\oemgmt\src`.)

   When you create your own report template, you must provide the name of the ABL program to run. To run a program that you've written, copy the program into `<OpenEdgeManagement-install-dir>/src` and include the fully qualified path of your program in the **Progress 4GL program to run** field.

   For more information about writing programs in the ABL, see OpenEdge Development: Programming Interfaces.

   b) In the **Title of generated report** field, enter the text that you want to use for the title in the report result.

   c) In the **Output file sub-directory** field, enter the location where the generated report output file will be stored when the report is run.
OpenEdge Management stores completed reports in a reports subdirectory in your working directory. You do not need to create this directory; OpenEdge Management creates it during the installation process. Within the reports subdirectory, there are subdirectories based on each Historical report type. Another set of subdirectories, based on the name of each report, is created within the report type subdirectories. OpenEdge Management names reports by their full path, followed by the year, month, day, hour, minute, and second of the report's generation, as well as by the site ID and the resource name.

The default directory for OpenEdge Management-provided reports is:

```
OpenEdgeManagement-install-directory\reports\<resource-type>
```

7. Click **Save** at the top of the **Report Template** page to save the report template properties.

   The second of two **Report Template** pages (the **Report Properties** page) appears with the **Name** field filled:

   ![Report Properties Page](image)

8. You must provide the following information:

   - **Description** — A description of the template.
   - **Output Formats** — Whether you want the report's output in text, HTML, or both.
• **Report period** — A previous number of days, or a block of days.

• **Time period** — Either full day or a block of time.

• **Display units** — The period of time, such as per second, per minute, per hour, per transaction, raw data, per record.

• **Environment** — Environment variables. Available environment variables depend on the type of report you are creating and your environment. For a list of environment variables available for the report, run the report with the **Generate debug log file** option on. The debug log file lists all environment variables and, if applicable, their values. Environment variables are proceeded by `env` in the log file.

For a detailed explanation about environment variables, see the chapter on jobs in *OpenEdge Management: Resource Monitoring*.

• **User name** — Your user name. Providing this information is optional; you can also run the report using another user's name. If you do not supply a name, the report runs under the account given in the AdminServer.

• **Password** — Your password (optional; required only if you also enter a user name).

• **4GL client parameters** — Any other client parameters you want to pass to the ABL program that produces the report output.

• **Generate debug log file** — Whether you want to create a debug log file. Creating a debug log file allows you to examine the report's environment variables. When viewing the debug log file, lines beginning with `env` show the names and values of applicable environment variables.

**Note:** See [Report instances](#) on page 16 for details about entering information into the **Report Properties** page.

9. Click **Save**. The **Report Template Summary** page appears.

You can now edit or copy the template's characteristics, delete the template, or create a report instance to run based on the template.

Once you create a report instance from a report template, the two are no longer tied together. You can modify the characteristics of a report instance without affecting the template, and you can update the template without affecting the characteristics of a report instance you have already created.

---

**Editing the report template**

Once you create a report template, you can edit it.

To edit a report template:

1. From the **Report Summary** page, click **Edit**. The first template page appears.

2. Make whatever edits you want and click **Save**. The second template page appears.

3. Make your edits and click **Save**. The **Report Summary** page appears, reflecting the changes you have made.
Copying the report template

You can copy the report template and use it as the basis for another template.

To copy a report template:

1. From the Report Summary page, click Copy. The first template page appears.
2. Enter a unique name and a unique menu entry in the fields provided.
3. Click Save.

Deleting the report template

After creating a report template, you may decide to delete it.

To delete a report template:

1. From the Report Summary page, click Delete. A message appears asking you to confirm that you want to delete the template.
2. Click OK to confirm the deletion.

Importing and exporting report templates

You can either import report templates into your own environment or export them to another environment.

For detailed information about importing and exporting templates, see OpenEdge Management: Resource Monitoring.
Real-time Reports

Real-time reports receive their information directly from resources. Because these reports are real-time, the data they contain represents the state of your system at the time of the report's generation.

For details, see the following topics:

- Introduction
- System Information report
- System Activity report
- Open Alert Detail report
- Hotspot report
- Database Summary report
- Open Alert Summary report
Introduction

To access real-time reports, select Reports > Go to Reports. The OpenEdge Management Reports page appears. Select the real-time reports from the Realtime Reports section of the page.

Figure 7: Real-time reports

You can run the following real-time reports:

- **Database Summary report** — Displays a summary report of all databases
- **Hotspot report** — Displays a report of all resources with open alerts
- **Open Alert Detail report** — Displays a detailed report of all open alerts
- **Open Alert Summary report** — Displays a summary report of all open alerts
- **System Activity report** — Displays system performance and resource utilization details identified by AdminServer
- **System Information report** — Displays system and operating system information details identified by AdminServer

The sections that follow describe the contents of each type of report.

**System Information report**

The System Information report displays the information shown in the following figure.
Table 31: System Information report details

<table>
<thead>
<tr>
<th>Category</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host information</td>
<td>Name of the host machine</td>
</tr>
<tr>
<td></td>
<td>IP address for the host machine</td>
</tr>
<tr>
<td></td>
<td>Host's system time</td>
</tr>
<tr>
<td></td>
<td>Host's system up-time</td>
</tr>
<tr>
<td>Operating system</td>
<td>Operating system name</td>
</tr>
<tr>
<td></td>
<td>Operating system version</td>
</tr>
<tr>
<td>OpenEdge Management</td>
<td>OpenEdge Management version number</td>
</tr>
<tr>
<td></td>
<td>OpenEdge Management install directory</td>
</tr>
<tr>
<td></td>
<td>OpenEdge Management work directory</td>
</tr>
<tr>
<td></td>
<td>OpenEdge Management report directory</td>
</tr>
<tr>
<td></td>
<td>OpenEdge Management up-time</td>
</tr>
<tr>
<td>OpenEdge</td>
<td>OpenEdge version</td>
</tr>
<tr>
<td></td>
<td>OpenEdge install directory</td>
</tr>
<tr>
<td>Java™</td>
<td>Java vendor</td>
</tr>
<tr>
<td></td>
<td>Java version</td>
</tr>
<tr>
<td></td>
<td>Java classpath</td>
</tr>
<tr>
<td>Paths</td>
<td>Library path</td>
</tr>
<tr>
<td></td>
<td>System path</td>
</tr>
</tbody>
</table>

**System Activity report**

The System Activity report displays the information shown in the following figure.

Table 32: System Activity report details

<table>
<thead>
<tr>
<th>Category</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host information</td>
<td>Name of the host machine</td>
</tr>
<tr>
<td></td>
<td>Operating system version</td>
</tr>
<tr>
<td></td>
<td>IP address</td>
</tr>
<tr>
<td></td>
<td>System up-time</td>
</tr>
</tbody>
</table>
## Open Alert Detail report

The Open Alert Detail report displays the following alert statistics:

- OpenEdge Management up-time
- Most recent alert
- Worst-case severity
- Number of open alerts
- Number of unseen alerts
- Number of open alerts from last hour
- Number of open alerts from last 24 hours
- Number of monitored resources
- Number of resources with alerts
- Percentage of resources with alerts
- Number of internal alerts

For each alert, the report lists:

- Severity
- First occurrence
- Last occurrence
- Occurrence count
- Reason

---

<table>
<thead>
<tr>
<th>Category</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU utilization</td>
<td>Percentage of CPU that is busy</td>
</tr>
<tr>
<td></td>
<td>Percentage of CPU being used</td>
</tr>
<tr>
<td></td>
<td>Percentage of CPU kernel being used</td>
</tr>
<tr>
<td></td>
<td>Percentage of CPU wait I/O</td>
</tr>
<tr>
<td>Memory utilization</td>
<td>Total system memory use</td>
</tr>
<tr>
<td></td>
<td>Total swap memory use</td>
</tr>
<tr>
<td></td>
<td>Pages input</td>
</tr>
<tr>
<td></td>
<td>Amount of system free/used</td>
</tr>
<tr>
<td></td>
<td>Amount of swap free/used</td>
</tr>
<tr>
<td></td>
<td>Pages output</td>
</tr>
</tbody>
</table>
Hotspot report

The Hotspot report displays the following information for each resource that is a hot spot:

• Last date and time of the alert
• Name of the alert
• Severity of the alert
• Count of the alert

Database Summary report

The Database Summary report displays the following information:

• Overall database statistics, including:
  • Total number of databases
  • Number of running databases
  • Number of databases licensed for monitoring
  • Number of databases with alerts
  • Percentage of databases with alerts

• Statistics for each database are listed separately and include:
  • Database location
  • Database status
  • Monitoring agent status
  • Polling status
  • Time in polling status
  • Number of alerts

Open Alert Summary report

The Open Alert Summary report displays the following alert statistics:

• OpenEdge Management up time
• Date and time of most recent alert
• Worst case severity
• Number of open alerts
• Number of unseen alerts
• Number of open alerts from last hour
• Number of open alerts from last 24 hours
• Number of monitored resources
• Number of resources with alerts
• Percentage of resources with alerts
• Number of internal alerts

The Open Alert Summary report also lists the following for each open alert:
• Last date and time of the alert
• AdminServer in which the monitored resource resides
• Monitored resource
• Name of the alert
• Severity of the alert
• Count of the alert
Diagnostic reports in OpenEdge Management provide information to help you and your Technical Support team debug OpenEdge Management problems. You can access Diagnostic reports from the OpenEdge Management Reports page.

To access the OpenEdge Management Reports page, click Reports from the OpenEdge Management console menu, and then click Go to Reports. In the Diagnostic Reports section of the page, select the following to view detailed reports: AdminServer Log File, Task Scheduler, and Work Scheduler.

For details, see the following topics:

- Viewing OpenEdge Management log files
- OpenEdge Management Task Scheduler
- OpenEdge Management Work Scheduler

Viewing OpenEdge Management log files

From the OpenEdge Management Reports page, you can access the AdminServer log file (admserv.log).
To access the log file, select **AdminServer Log File** in the **Diagnostic Reports** section. The log file appears:

You can work with the file as follows:

- Click **First** to go to the beginning of the file.
- Click **Prior** to see the same number of entries preceding those you are currently viewing. For example, if you are viewing 20 entries and you click **Prior**, the preceding 20 entries appear.
- Click **Next** to see the same number of entries following those you are currently viewing. For example, if you are viewing 20 entries and you click **Next**, the following 20 entries appear.
- Click **Last** to see the final entries in the log file.
- Click **Reload** to refresh the log file.
- To go to a particular entry in the file, type the line number in the **Go To** field, and then click **Go To**.
- To specify how many entries you want to see at one time, type the number in the **Show** field. You can also specify how many entries can overlap in the **Overlap** field.
- Choose either **Ascending** or **Descending** to specify the sort order of the log file.

**OpenEdge Management Task Scheduler**

The **Task Scheduler** page is provided for OpenEdge Management diagnostic purposes. The Task Scheduler handles execution of jobs and reports, and provides work queue backlog and scheduling information.

To access the Task Scheduler, select **Task Scheduler** in the **Diagnostic Reports** section. The **OpenEdge Management Task Scheduler Diagnostics** page appears with the following information:
### Table 33: Task Scheduler Diagnostics

<table>
<thead>
<tr>
<th>Table</th>
<th>Column heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>Internal name of the schedule</td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td>Owning job or report resource name</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Type of task (job or report)</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the task (disabled or scheduled)</td>
<td></td>
</tr>
<tr>
<td>Next Run</td>
<td>Next scheduled run after the present time</td>
<td></td>
</tr>
<tr>
<td>Run Count</td>
<td>Number of times the scheduled task has run since OpenEdge Management started</td>
<td></td>
</tr>
<tr>
<td>Triggers</td>
<td>Name of any schedule triggers, if present (triggers contain the actual scheduling information)</td>
<td></td>
</tr>
<tr>
<td>Trigger</td>
<td>Internal name of the trigger, if one is present</td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td>Name of the owning schedule (this will match the names listed in the schedule table)</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the trigger: complete, default, error, none, normal, or paused</td>
<td></td>
</tr>
<tr>
<td>Previous Run</td>
<td>Time stamp of the trigger's previous run</td>
<td></td>
</tr>
<tr>
<td>Next Run</td>
<td>Time the trigger is next scheduled to run</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If the defined tasks are not scheduled to run (that is, they do not have a schedule defined or their schedules are not enabled), only the **Schedule** table appears on the **Task Scheduler** page.

OpenEdge Management uses the Quartz Enterprise Job Scheduler to run tasks. The **Restart** button allows you to stop, clear the current configuration and restart the Quartz Scheduler. Use the **Restart** button only when directed to do so by Technical Support.

**Note:** For more information about the Quartz Enterprise Job Scheduler, see [http://www.quartzscheduler.org](http://www.quartzscheduler.org).

---

**OpenEdge Management Work Scheduler**

The **Work Scheduler** diagnostic pages provide information to help you and your Technical Support team debug OpenEdge Management problems. Each diagnostic page of OpenEdge Management Work Scheduler is described below:
• **Work Scheduler** — Select the **Work Scheduler** tab to view information about all work queues hosted by OpenEdge Management in the **OpenEdge Management Work Scheduler Diagnostics** page. Each column in this page represents a work queue and provides information about the status of the work queue, number of scheduled and dropped items, thread configuration, and queue backlog.

The following work queues are available in the **OpenEdge Management Work Scheduler Diagnostics** page:

- **Scheduled Work** — This work queue handles polling of resources, writing data to graph cache database, and execution of rules.
- **Unscheduled Work** — This work queue handles execution of actions for alerts that are fired such as sending emails and writing data to log files.
- **Trend Work** — This work queue handles polling of resources and writing data to trend database.

The default values of work queue properties can handle most of the configurations. However, for larger configurations, if required, you can increase the values of these properties in the `fathom.init.params` file.

Additionally, use the **Thread Detail** button under each work queue to view more details in the **OpenEdge Management Thread Diagnostics** page.

• **Resource Scheduler Details** — Select the **Resource Scheduler Details** tab to view the following information of every resource that can be polled:

- The state of the resource as IDLE, QUEUED, POLLING, or INIT.
- The number of polls occurred for the resource.
- The time interval specified for polling and the time when the next poll occurs in seconds.
- The current watch that dictates how often a resource must be polled and its current schedule.
- The time when the last poll was scheduled, started, finished, or failed.
- The length or duration of the last poll.

• **Work Scheduler Queue** — Select the **Work Scheduler Queue** tab to view a list of work queues that are backlog and pending for activation by the Work Scheduler in the **OpenEdge Management Work Scheduler Diagnostics** page.

As polling of a resource often takes less than a couple of seconds, the list of work queue backlog might appear empty. However, in cases when there are many resources that should be polled at the same time and the CPU utilization is too high to poll, you might find a list of work queue backlog in this page.

• **Task Scheduler** — See **OpenEdge Management Task Scheduler** on page 60.

• **AdminServer Threads** — Select the **AdminServer Threads** tab to view multi-threaded dump of all the threads for OpenEdge Management and the current stack of each thread running for the AdminServer.

• **Resource Activity History** — Select the **Resource Activity History** tab to view data available for a resource in the graph cache. In the **Resource Activity History** page, select a resource, an entity, and a time period to view all the raw data available in the graph cache for that resource at that specific time.

• **Logging** — Select the **Logging** tab to view the **Log Console** page which allows you to change the logging levels for various logging subsystems. You can select a level for each individual logging subsystem or use the **Global write level** drop-down list to select a level for all the subsystems.

Additionally, use the **AdminServer Log File Viewer** button to view the contents of an AdminServer log file in an HTML interface. For more information, see **Viewing OpenEdge Management log files** on page 59.
**Note:** Restarting the AdminServer resets the levels of the subsystems to their default levels.

- **System** — Select the **System** tab to view graphs that display CPU and memory utilized, memory pages paged in and out, and JVM memory utilized by the AdminServer over a period of time in the **System Overview** page.
Index

A
ABL (formerly 4GL) and running reports 47
AppServer Application Profile report 32
AppServer Performance report 33
AppServer reports
   AppServer Application Profile 18, 31–32
   AppServer Performance 18, 33

C
CPU Summary report 38
Cron expressions 41

D
Database After-imaging report 33
Database Area Status report 33
Database Before-imaging report 34
Database Buffer I/O report 36
Database Checkpointing report 34
Database Details report 34
Database Disk Information report 35
Database Index Analysis report 36
Database Index Usage report 36
Database Locking report 36
Database Record Information report 37
Database reports
   Database After-imaging 33
   Database Area Status 33
   Database Before-imaging 34
   Database Buffer I/O 36
   Database Checkpointing 34
   Database Details 34
   Database Disk Information 35
   Database Index Analysis 36
   Database Index Usage 36
   Database Locking 36
   Database Record Information 37
   Database Server Activity 37
   Database Summary 37
   Database Table Analysis 38
   Database Table Usage 38
Database Server Activity report 37
Database Summary report 37
Database Table Analysis report 38
Database Table Usage report 38
Diagnostic reports
   Task Scheduler 16, 60
   Work Scheduler 16, 61

E
Environment variables
   fathomResourcesPerGraph 29
   GRAPH1COLUMNS 29
Exit codes 43

F
File Summary report 38

G
General reports
   Resource Alert Detail 18
   Resource Status Detail 18

H
Historical reports
   customizing graphical report output 29
   environment variables 29

I
Importing and exporting report templates 52

L
Log file viewer 16, 59

N
Network Activity report 39

R
Real-time reports
   Database Summary 54, 57
   Hotspot 54, 57
   Open Alert Detail 54, 56
   Open Alert Summary 54, 57
   System Activity 54–55
   System Information 54
Reports
   creating
      an instance 16
      templates for 47
determining what type to create 22
diagnostic 16, 59
Reports (continued)
directory 47
historical 16
history 15
log file 16
output 15
real-time 16, 54
running immediately 41
scheduling to run 41
template
importing and exporting 52
menu properties 47
properties 47
resource site and source 47
summary 47
templates 21
terminology 15
trend 21
types provided by OpenEdge Management 22
using ABL (formerly Progress 4GL) to run 47
viewing
a list of output files 42
completed 44
history 43
log file 59
output 42
running 45
scheduled 44
the last output file 42
Running a report immediately 41

S
System Disk Device Activity report 39
System Filesystem Usage report 39
System Memory Summary report 39
System reports
   CPU Summary 18, 30, 38
   File Summary 38
   Network Activity 18, 39
   System Disk Device Activity 18, 39
   System Filesystem Usage 39
   System Memory Summary 18, 39

T
Task Scheduler 16, 60

V
Viewing
completed reports 44
report history 43
running reports 45
scheduled reports 44

W
WebSpeed Application Profile report 39
WebSpeed Performance report 40
WebSpeed reports
   WebSpeed Application Profile 18, 39
   WebSpeed Performance 18, 40
Work Scheduler 16, 61